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1. Dulezité

Tato elektronickd uzivatelska prirucka je urcena
pro kazdého uzivatele tohoto monitoru
Philips. Pred pouzivanim monitoru si prectéte
tuto uzivatelskou prirucku. Obsahuje dllezité
informace a pozndmky k pouzivani vaseho
monitoru.

Zaruka Philips je platnd, pokud je vyrobek
pouzivdn pro navrzenou potrebu v souladu

s ndvodem a po priloZenf origindlu faktury
nebo pokladnim dokladem, oznacujicim datum
nadkupu, jméno prodejce a modelové a vyrobnf
¢islo vyrobku.

1.1 Bezpecnostni opatreni a Udrzba

) Varovani

PouZitf kontrol, Uprav nebo postupt jinym
zpUsobem nez je stanoveno v této dokumentaci
muZe vést k ohrozenf Sokem, elektrickym a/
nebo mechanickym riziklm.

Prectéte si a dodrzujte tyto instrukce pri

zapojovdn( a pouzivdni vaSeho pocitatového

monitoru:

Pouzivani

*  Nevystavujte monitor primému slunecnimu
zdfenf, velmi silnym jasnym svétlim a
udrzujte jej mimo dosah jinych zdrojl tepla.
Dlouhé vystaven( tomuto typu prostredf

muze mit za ndsledek zménu barev a
poskozeni monitoru.

»  Odstranite veskeré predméty, které by
mohly spadnout do vétracich otvord nebo
zabranit dostate¢nému chlazenf elektroniky
monitoru.

*  Nezakryvejte vétraci otvory ve skffice.

*  Umlistéte monitor na takové misto, ze
kterého bude elektrickd zdstr¢ka a zdsuvka
snadno pristupna.

*  Jestlize jste vypnuli monitor odpojenim
napdjectho kabelu nebo kabelu napdjectho
adaptéru, pred pripojenim kabelu pockejte
6 sekund, aby monitor fungoval normalné.

* Vzdy pouzivejte napdjeci kabel schvdleny
spole¢nosti Philips. Pokud napdjeci kabel
chybf, obratte se na nejblizsi servisnf
stredisko. (Viz informace o strediscich
zékaznické péce)

*  Béhem pouZzivani nevystavujte monitor
nadmeérnym otresiim nebo ndrazdim.

*  Pri pouzivani nebo premistovdni do
monitoru nekopejte a zabrarite prfpadnému
pédu.

Udrzba

*  Aby byl monitor chrdnén pred moznym
poskozenim, nevyvijejte na panel LCD
nadmérny tlak. Pri premistovéni zvedejte

monitor za rdm; pri zveddni monitoru
nesahejte rukou nebo prsty na panel LCD.

* Nebudete-li monitor delsi dobu pouzivat,
odpojte jej ze zdsuvky.

e Pred odistenim mirn& navihcenym
hadrfkem monitor odpojte ze zdsuvky.
Je-li vypnuté napdjent, Ize obrazovku otrit
suchym hadrikem. K &igténi monitoru nikdy
nepouzivejte organickd rozpoustédla, jako
napriklad alkohol nebo distice s obsahem
¢pavku.

» Zabrarite nebezpedi Urazu elektrickym
proudem nebo trvalého poskozenf
monitoru a chrarite monitor pried prachem,
destém, vodou nebo nadmérné vihkym
prostredim.

*  Pokud dojde k namoceni monitoru, co
nejdrive jej osuste suchym hadrkem.

*  Vnikne-li do monitoru ciz ldtka nebo voda,
ihned vypnéte napdjeni a odpojte napdject
kabel. Odstrarite cizf latku nebo vodu z
monitoru a odeslete jej do servisniho
strediska.

*  Monitor neskladujte ani nepouzivejte
na mistech vystavenych teplu, pffmému
slune¢nimu zdreni nebo extrémnim
teplotdm.

*  Chcete-li zachovat optimalnf vykonnost
monitoru a prodlouZit jeho Zivotnost,
pouZivejte jej na miste, které spliiuje
nasledujici rozsahy teplot a vihkosti.



* Teplota: 0-40°C 32-95°F
* Vihkost: 20-80% relativni vihkosti

Dulezité informace o vypalovani duchd/
stinového obrazu

* Pred ponechdnim monitoru bez dozoru
vzdy aktivujte spori¢ obrazovky. Bude-li
na vasem monitoru zobrazen neménicf
se staticky obsah, vzdy aktivujte aplikaci
pro pravidelnou obnovu obrazovky.
Dlouhodobé neprerusované zobrazenf
nehybného nebo statického obrazu mize
zpUsobit ,,vypéleni* obrazovky, rovnéz
znamé jako ,,dosvit"* nebo , zobrazenf
duchd*™.

e Vypéleni,, dosvit" nebo ,zobrazenf
duchd" je dobre zndmy jev u technologie
panell LCD.V mnoha pripadech ,vypéleni*,
,,dosvit"* nebo ,zobrazeni duchd" postupné
zmizi po urcité dobé mimo provoz.

(D Vystraha

Pokud neaktivujete spofi¢ obrazovky nebo
aplikaci, kterd pravidelné obménuje obsah
zobrazenf, mdze dojit k vdznému ,,vypdleni”,
dosvitu' nebo ,,zobrazeni duchd", a toto
naruseni obrazu jiz nelze odstranit. Na vyse
uvedené poskozeni se nevztahuje zdruka.

Servis

*  Kryt pldsté mize oteviit pouze kvalifikovany
servisni pracovnik.

* Pokud je pro opravu vyzadovéna
dokumentace nebo integrace, obratte se
na nejblizs( servisnf stredisko. (Viz kapitola
,,Stredisko zdkaznickych informaci*)

* Informace o prevdzeni najdete v asti
,, Technické ddaje".

* Neponechdvejte monitor v auté nebo v
zavazadlovém prostoru auta na primém
slunci.

© Poznimka

Pokud monitor nefunguje spravné nebo pokud
si nejste jisti, jaké kroky je treba provést po
provedeni pokynU v této prirucce, obrat'te se na
servisniho pracovnika.

1.2 Vysvétleni zapisu

Nasledujici pododdily popisujf zplsob zdpisu,
ktery se pouzivd v této prirucce.

Poznamky, upozornéni a vystrahy

Na strankdch této prirucky mlzete narazit na
text, ktery je opatreny symbolem a je vytistén
tucné nebo kurzivou. Takové Useky obsahujf
poznamky, upozornéni a vystrahy. Jejich pouzitf
je nasledujict:

€& Poznimka

Tento symbol oznacuje dilezité informace a
ndvrhy, které poméhajf Iépe vyuzit pocitacovy
systém.

© Upozornéni

Tento symbol oznacuje informace, které
objasniuji, jak se vyhnout moznému poskozenf
zafizeni nebo ztrdté dat.

D Vystraha

Tento symbol oznacuje nebezped( télesného
ubliZzenf a vysvétluje, jak se danému problému
vyhnout.

Nekteré vystrahy se mohou objevit v riizné
podobg a nemusi byt uvozeny symbolem.V
takovém pripade je konkrétni vyznaceni vystrahy
naf{zeno Uradem pro regulaci.



1.3 Likvidace produktu a obalového
materialu

Likvidace elektrickych a elektronickych
zarizeni - WEEE

This marking on the product or on its
packaging illustrates that, under European
Directive 2002/96/EC governing used electrical
and electronic appliances, this product may
not be disposed of with normal household
waste.You are responsible for disposal of

this equipment through a designated waste
electrical and electronic equipment collection.
To determine the locations for dropping off
such waste electrical and electronic, contact
your local government office, the waste disposal
organization that serves your household or the
store at which you purchased the product.

Your new monitor contains materials that can
be recycled and reused. Specialized companies
can recycle your product to increase the
amount of reusable materials and to minimize
the amount to be disposed of.

All redundant packing material has been
omitted. We have done our utmost to make the
packaging easily separable into mono materials.

Please find out about the local regulations on
how to dispose of your old monitor and packing
from your sales representative.

Taking back/Recycling Information for
Customers

Philips establishes technically and economically
viable objectives to optimize the environmental
performance of the organization's product,
service and activities.

From the planning, design and production
stages, Philips emphasizes the important of
making products that can easily be recycled. At
Philips, end-of-life management primarily entails
participation in national take-back initiatives
and recycling programs whenever possible,
preferably in cooperation with competitors,
which recycle all materials (products and related
packaging material) in accordance with all
Environmental Laws and taking back program
with the contractor company.

Your display is manufactured with high quality
materials and components which can be
recycled and reused.

To learn more about our recycling

program please visit: http://www.philips.
com/sites/philipsglobal/about/sustainability/
ourenvironment/productrecyclingservices.page.




, . Namontujte stojanek podstavce
2. Nastaveni monitoru Bl Namontujte stojének podstav

1. Umistéte monitor obrazovkou dold na
mekky a hladky podklad, aby nedoslo k
poskrdbani obrazovky.

2.1 Instalace

El Obsah krabice

Uchopte podstavec obéma rukama.

(1) Jemné nasadte podstavec na oblast
drzéku VESA a7 jej zapadky zajisti.

(2) Prsty utdhnéte Sroub na spodnf strané
zékladny a pevné zajistéte zdkladnu ke
stojanu.

Adaptér stridavého/ VGA (volitelné) HDMI (volitelné)
stejnosmérného napajeni

€& Pozniamka

Pouzivejte pouze sitovy adaptér stridavého/
stejnosmérného napdjent:

Philips ADPC1945(238C4QH)




El Prfipojeni k poitadi

2.2 Ovladani monitoru

El Popis vyrobku z Eelniho pohledu

PHILIPS
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0 Vstup stejnosmérného napdjenf
@ VstupVGA

© Vstupy HDMI (HDMI1, HDMIR)
© Vystup zvuku HDMI

© Zimek proti kridezi Kensington
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Pripojeni k pocitaci napajeni monitoru.
1. Pevné pripojte napdjeci kabel k zadnf strané Slou#f ke vstupu do nabidky
monitoru. 0 /0K 0osh.
2. Vypnéte potitat a odpojte jeho napdject Potvrzenf nastaveni OSD.
kabel. © | A 'V [Slousi k Upravam nabidky OSD.
3. Pripojte signdlovy l<,abe| rrjonit?,ruvdo video o o Slouz( ke zméné zdroje
konektoru na zadnf strané pocftace. vstupniho signalu.
4. Zapojte napdjeci kabel pocitace a monitoru o
do nejblizéf zasuvky. (5) \,& Pouzitf funkce Turbo
5. Zapnéte pocita¢ a monitor. Jestlize se 0o < Slouzi k ndvratu na predchozf
na monitoru objevi obraz, instalace je drovers OSD.
dokoncena. Rychlé tladftko Smartlmage
Lze vybrat néktery ze sedmi
rezimd: Text, Office (Kancelar),
o @ Photo (Fotografie), Movie
(Film), Game (Hra), Economy
(Usporny), Off (Vypnuto).




E1 Popis zobrazeni funkci na obrazovce

Co je nabidka na obrazovce (OSD)?

Funkcf nabidky obrazovky (On-Screen Display,
OSD) jsou vybaveny vSechny monitory

LCD Philips. Umozriuje koncovému uzivateli
upravovat vlastnosti obrazovky nebo vybirat
funkce monitoru prfmo prostrednictvim
zobrazeného okna s pokyny. Nize je uveden
priklad prijemného rozhrani obrazovky:

I VGA
n
5 " HDMI1

HDMI2

Zakladni a jednoduché pokyny k ovladacim
tlacitkim

Ve vySe uvedené nabidce obrazovky OSD
mUZzete stisknutim tlacitek ¥ A na prednim
rdmecku monitoru pohybovat kurzorem a
stisknutim OK potvrdit vybér nebo zménu.

Nabidka OSD

NiZe je uveden celkovy pohled na strukturu
OSD. Tento prehled mizete vyuzit, budete-li
chtit pozd&ji prozkoumat rdiznd nastaven.

Sub menu

VGA
E HDMI1
HDMI2

— Picture Picture Format —— Wide Screen, 4:3
Brightness — 0~100
Contrast — 0~100
SmartKolor — On, Off
SmartTxt — On, Off
SmartResponse —— Off, Fast, Faster, Fastest
SmartContrast — On, Off
Gamma — 1.8,20,22,24,26

Main menu

— Input

Pixel Orbiting — On, Off
Over Scan — On, Off

— Audio Volume — 0~100

Mute — On, Off
— Color Color Temperature 5000K, 6500K, 7500K,
8200K, 9300K, 11500K
sRGB
User Define Red: 0~100
Green: 0~100
Blue: 0~100
— Language — English, Espaiol, Frangais, Deutsch, Italiano,
Portugués, Pycckmit, fE{&F 3
— OSD Settings ™ Horizontal — 0~100
— Vertical — 0~100
f— Transparency — Off1,2,3,4
— OSD Time Out — 5s,10s, 20s, 30s, 60s
L— Setup — Auto
— H.Position — 0~100
— V.Position — 0~100
— Phase — 0~100
— Clock — 0~100
— Resolution Notification — On, Off
— Reset — Yes,No
L— Information



El Poznamka k rozliseni

Tento monitor je urcen pro optimdini vykon
pfi nativnim rozliseni 1920 x 1080 pri 60 Hz.
Kdyz je monitor zapnut pfi jiném rozlisenf, na
obrazovce se zobrazi vystraha: Use 1920 x
1080 @ 60 Hz for best results (Pro optimaln(
vysledek pouzijte rozliseni 1920 x 1080 pri 60
Hz).

Zobrazovani vystrahy na nativni rozlisenf Ize
vypnout v ¢ésti Nastaveni v nabidce OSD.

B Fyzické funkce

Naklon
20°

\‘ -
-5

@



3. Optimalizace Obrazu

3.1 Smartlmage

El Cojeto?

Funkce Smartlmage nabizf scéndre, které
optimalizujf zobrazenf( rdznych typd obsahu a
dynamicky zlepsuje jas, kontrast, barvy a ostrost
v redlném case. Funkce Philips Smartimage
prindsi optimalizované zobrazeni monitoru

bez ohledu na to, zda pracujete s aplikacemi,
prohlizite obrdzky nebo sledujete video.

E1 Proé to potrebuii?

Protoze chcete sledovat monitor, ktery

prindsi optimalizované zobrazenf viech vasich
oblibenych typl obsahu. Software Smartimage
dynamicky upravuje jas, kontrast, barvy a ostrost
v redlném case pro dosazeni nejlepsiho zazitku
ze sledovani monitoru.

El Jak to funguje?

Smartimage exkluzivni $pi¢kova technologie
spolecnosti Philips, kterd analyzuje obsah
zobrazeny na obrazovce. Na zékladé vami
zvoleného scéndre technologie Smartimage
dynamicky zlepsuje kontrast, sytost barev a
ostrost obrazu pro vylepseni zobrazovaného
obsahu — vse v redlném case stisknutim jediného
tlacitka.

B Jak aktivovat Smartimage?

1. Stisknutim @D spustite Smartlmage na
obrazovce.

2. Opakovanym stisknutim B mazete
prepinat mezi rezimy Text (Text), Office

(Kanceldr), Photo (Fotografie), Movie (Film),
Game (Hra), Economy (Usporny) a Off
(Vypnuto).

3. Zobrazeni Smartlmage zUstane na
obrazovce po dobu 5 sekund nebo muZzete
rovnéz potvrdit stisknutim tlacitka ,,OK".

4. Po aktivaci technologie Smartlmage je
automaticky deaktivovdno schéma sRGB.
Aby bylo mozné pouzit schéma sRGB,
je tfeba deaktivovat funkci Smartlmage
stisknutim tlacitka B na prednim panelu
monitoru.

Kromé tlacitka @) pro prochédzeni dold mizete

rovnéz provést vybér stisknutim tlalftek w A,

potvrdit vybér stisknutim tlacftka ,,OK" a ukondit

nabidku Smartimage OSD.

Lze vybrat néktery ze sedmi rezim(: Text (Text),
Office (Kanceldr), Photo (Fotografie), Movie
(Film), Game (Hra), Economy (Usporny), Off
(Vypnuto).

@ SmartImage

Text

Office
Photo
Movie

Game

Economy

Off

»  Text (Text): Pomdha zlepsit Citelnost textu
napriklad v elektronickych knihdach PDF
Diky zvlastnimu algoritmu zvysujicimu
kontrast a ostrost hran textu je zobrazen{
automatickym nastavenim jasu, kontrastu a
teploty barev optimalizovdno pro pohodiné
¢teni bez Unavy odf.

» Office (Kancelar): Vylepsuje text a
snizuje jas pro zvysenf Citelnosti a omezen(
naméhan( zraku. Tento rezim podstatné
zvysuje Citelnost a produktivitu pri préci
s tabulkami, soubory PDF, skenovanymi
¢lanky nebo jinymi obecnymi kanceldrskymi
aplikacemi.



*  Photo (Fotografie): Tento profil kombinuje
vylepsenf sytosti barev, dynamického
kontrastu a ostrosti pro zobrazenf fotografif
a daldich obrdzkd s vynikajicf Cistotou v
Zivych barvéch — to vse bez artefaktl a
vybledlych barev.

*  Movie (Film): ZvySend svitivost,
prohloubend sytost barev, dynamicky
kontrast a Ziletkovd ostrost zobrazujf
kaZdy detail v tmavsich ¢dstech videa bez
deformace barev v jasnéjsich ¢astech a
udrzujf dynamické prirozené hodnoty pro
dokonalé zobrazenf videa.

*  Game (Hra): Tento profil prindsi nejlepsi
herni zdZitek pro hrdce, protoZe aktivuje
prebuzeny okruh pro optimdlni dobu
odezvy, omezen( zubatych okraji rychle
se pohybujicich objektd na obrazovce a
vylepsenf kontrastntho poméru pro jasné a
tmavé scény.

+  Economy (Usporny): V tomto profilu jsou
upraveny jas a kontrast a jemné vyladéno
podsviceni pro zajisténi optimélniho
zobrazeni béznych kancelarskych aplikaci a
nizsi spotfebu energie.

e Off (Vypnuto): Nenf pouzita optimalizace
funkce Smartlmage.

3.2 SmartKolor

El Cojeto?

SmartKolor je zvlastni technologie, kterd dokdze
zlepsit vizudlni podan( barev a prindsi vdm tak
Zivy a bohaty obraz.

E1 Pro¢ to potrebuii?
Urcité si prejete bohaty obraz , jako Zivy", abyste
si pné vychutnali fotografie a video.

E Jak to funguje?

SmartKolor dynamicky vylepsuje sytost barev
a zlepsuje vizudlni barevné rozmezi a poskytuje
tak lepsi barvy a vykon pri sledovéni obrazu.
SmartKolor se automaticky vypne v rezimech,
kdy jej nepotrebujete, napriklad Text nebo
Kanceldr.

3.3 SmartContrast

El Cojeto?

Jedinecna technologie, kterd dynamicky analyzuje
zobrazeny obsah a automaticky optimalizuje
kontrastnf pomér monitoru pro maximélnf
vizudlni Cistotu a pozitek ze sledovéni. Zvysuje
podsviceni pro jasnéjsi, ostrejsi a jasnéjsi obraz
nebo snizuje podsviceni pro jasné zobrazenf
obrazu s tmavym pozadim.

E1 Prog to potiebuii?

Zédate nejvy33i vizudlni Cistotu a pohodli
sledovant jakéhokoli typu obsahu. SmartContrast
dynamicky r{df kontrast a upravuje podsvicenf
pro jasné, ostré a jasné zobrazen( her a videa
nebo pro zobrazenf jasného, Citelného textu

pro kancelarskou préci. Omezenim spotreby
monitoru Setrfte ndklady a prodluzujete Zivot
vaseho monitoru.

E Jak to funguje?

Po aktivaci bude funkce SmartContrast v
redlném case analyzovat zobrazeny obsah a
upravovat barvy a ridit intenzitu podsvicenf. Tato
funkce bude dynamicky vylepSovat kontrast pro
skvély zdzitek pri prohlizeni fotografii nebo hranf
her.

3.4 Philips SmartControl Premium

Novy software SmartControl Premium od
spolecnosti Philips umozriuje ovladat monitor
prostrrednictvim snadno pouzitelného grafického
rozhrani na obrazovce. SloZita nastaven( jsou
minulosti, protoze tento uZzivatelsky prijemny
software vds provede jemnym vyladénim
rozlisent, kalibraci barev, nastavenim frekvence/
faze, nastavenim bilého bodu RGB atd.

Tento software zalozeny na pritazlivych
animovanych ikondch kompatibiln{ se systémem
Windows 7, ktery je vybaven nejnovéjsi
technologif v jddrovém algoritmu pro rychlé
zpracovani a odezvu, je pripraven rozsifit vasi
zkusenost s monitory Philips!



El Instalace

» Postupujte podle pokynli a dokoncete
instalaci.

* Mdzete spustit po dokonceni instalace.

*  Chcete-li spustit pozdégji, mizete klepnout
na zéstupce na pracovni plose nebo na
panel nastroju.

E———

PHILIPS

Prvni spusténi — Privodce

e Pri prvnim spusténi po instalaci prejde
SmartControl Premium automaticky na
Prévodce.

* Tento privodce vds provede podrobnym
nastavenim vykonu monitoru.

*  Prlvodce mlZete rovnéz spustit pozdéji z
nabidky Plug-in (Zasuvny modul).

*  Dalsif moznosti mizZete nastavit bez
prdvodce prostfednictvim podokna
Standard (Standardni).

[~ P T
SmartControl Premium PHILIPS

Wizard
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B3 Spusténi s podoknem Standard
(Standardni)

Nabidka Adjust (Nastaveni)

* Nabidka Adjust (Nastaveni) umozriuje
upravit Brightness (Jas), Contrast (Kontrast),
Focus (Ohnisko), Position (Poloha) a
Resolution (Rozlisent).

*  Mulzete postupovat podle pokynt a provést

nastaven.

* Cancel (Storno) vyziva uzivatele, chcete-li
ukoncit instalaci.
SmartControl Premium PHILIPS
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Resalution

Nabidka Color (Barva)

* Nabidka Color (Barva) umozriuje upravit
RGB, Black Level (Uroven ¢erné), White
Point (Bily bod), Color Calibration
(Kalibrace barev) a Smartimage (viz ¢ast
Smartlmage).

*  Mdzete postupovat podle pokynd a provést

nastaven.

* V ndsledujici tabulce vyhledejte polozku
podnabidky na zdkladé vaseho vstupu.

» Priklad pro Color Calibration (Kalibrace
barev).
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Tlacitko ,,Show Me" (Predvést) spustf
vyukovy program pro kalibraci barev.

Start (Spustit) — zahdjf sekvenci kalibrace
barev o 6. krocich.

Quick View (Rychlé zobrazenf) nacte
zobrazeni pred/po.

Chcete-li se vrdtit na hlavni strdnku Color
(Barva), klepnéte na tlacitko Cancel
(Storno).

Enable color calibration (Povolit kalibraci
barev) — ve vychoz( konfiguraci je zapnuto.
Pokud tato polozka nenf zaskrtnuta,
kalibraci barev nelze provést a tlacitka Start
(Spustit) a Quick View (Rychlé zobrazenf)
nejsou k dispozici.

Na kalibracni obrazovce musi byt
zobrazeny informace o patentech.
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Obrazovka kalibrace prvni barva

Tlacitko Previous (Predchozi) je
deaktivovdno az na obrazovku druhé barvy.

Tlacitko Next (Dalsi) slouzi k prechodu na
nasledujici il (6 cild).

Nakonec prejdéte na podokno File >
Presets (Soubor > Predvolby).

Tlacitko Cancel (Storno) slouzi k ukoncenf
uZzivatelského rozhranf a k ndvratu na
stranku Plug-in (Zdsuvny modul).

Smartlmage

Smartimage — umozriuje uzivateli zménit
nastaveni pro vylepseni zobrazenf na zakladé
obsahu.

Kdyz je nastavena moznost Entertainment
(Zabava), jsou polozky SmartContrast a
SmartResponse k dispozici.
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Nabidka ECO
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Schedube Power Savings
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Nabidka Options (Moznosti)

Podokno Theft Deterrence (Zabezpecen proti
krddezi) bude aktivni pouze po vybéru polozky
Theft Deterrence Mode (Rezim zabezpecen(
proti krddezi) z rozeviraci nabidky Plug-in
(Zasuvny modul).

SmartControl Premium PHILIPS

Theft Deterrence

Chcete-li aktivovat Theft Deterence

(Zabezpeceni proti krddezi), kliknéte na tlacitko

Enable Theft Deterrence Mode (Aktivovat

rezim zabezpecen( proti krddezi) a zobrazi se

nasleduijici okno:

*  Uzivatel mdze zadat kod PIN, ktery
obsahuje pouze 4 az 9 dislic.

*  Po zadanf kédu PIN a kliknutl na tlacitko

Accept (Prijmout) se zobrazi mistnf
dialogové okno na ndsledujici strénce.

e Minimdlni pocet minut nastaven na 5.
Posuvnik nastaven ve vychozi konfiguraci
na 5.

* Aby bylo mozné prejit do rezimu Theft
Deterence (Zabezpecen( proti krddezi),
zobrazovac( zar{zenf nemusi byt pripojeno k
odlisnému hostiteli.

Po vytvoren( kédu PIN bude na podokné

Theft Deterence (Zabezpecen proti krddeZzi)
zobrazena informace Theft Deterence
(Zabezpecleni proti krddezi) aktivovdno a bude
k dispozici tlacitko PIN Options (Moznosti kddu
PIN):

* e zobrazena informace Theft Deterrence
(Zabezpeclen proti krddezi) aktivovano.

*  Kliknutim na tlacftko deaktivovat Theft
Deterrence (Zabezpecen proti krddezi) se
otev'e podokno na nésledujici strané.

» Tlacitko PIN Options (Moznosti kédu PIN)
je k dispozici pouze po vytvoreni kédu PIN
a slouZf k otevren( serveru zabezpeceného
kodem PIN.

Options>Preferences (Moznosti>Predvolby) —
Tato moznost bude aktivni pouze po

vybéru polozky Preferences (Predvolby) v
rozeviraci nabidce Options (Moznosti). Na
nepodporovaném zobrazovacim zarizen( s
podporou DDC/Cl jsou k dispozici pouze karty
Help (Ndpovéda) a Options (Moznosti).
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Zobraz( nastaveni aktudlnich predvoleb.

Zaskrtnuté tlacitko aktivuje funkci.
Zaskrtdvacf poli¢ko je prepinac.

Polozka Enable Context Menu (Povolit
mistni nabidku) na pracovni plose je ve
vychozi konfiguraci zaskrtnutd (Zapnuto).
Po aktivaci polozky Enable Context Menu
(Povolit mistni nabidku) se na pracovni
plose zobrazi vybéry SmartControl
Premium pro funkce Select Preset
(Vybrat predvolbu) a Tune Display (Ladénf
zobrazeni), pokud klepnutim pravym
tlacitkem mysi zobrazite mistni nabidku.
Volbou moznosti Deaktivovdno bude
polozka SmartControl Premium odstranéna
z mistni nabidky pravym tlacftkem mysi.
Polozka Enable Task Tray (Povolit ikonu na
hlavnim panelu) je ve vychozi konfiguraci
zaskrtnutd (Zapnuto). Po aktivaci polozky
Enable Context Menu (Povolit mistn{
nabidku) se zobrazi nabidka SmartControl
Premium na hlavnim panelu. Klepnutim
pravym tlacitkem mysi na ikonu na hlavnim
panelu se zobrazi moznosti nabidky Help
(Napovéda), Technical Support (Odbornd
pomoc), Check for Update (Vyhledat
aktualizace), About (O aplikaci) a Exit
(Konec). Kdyz je deaktivovana polozka
Enable task tray menu (Povolit nabidku na
hlavnim panelu), ikona na hlavnim panelu
zobrazuje pouze moznost EXIT (KONEC).

Polozka Run at Startup (Spustit pri startu)
je ve vychozi konfiguraci zaskrtnutd
(Zapnuto). Kdyz je tato polozka
deaktivovana, funkce SmartControl
Premium se nespusti pfi startu nebo
nebude na hlavnim panelu. Funkci
SmartControl Premium Ize spustit pouze
prostrednictvim zdstupce na pracovni plose
nebo prostrednictvim souboru programu.
Kdyz toto poli¢ko nenf zaskrtnuté
(Deaktivovdno), zadnd predvolba nastavend
pro spusténi pri startu nebude nactena.

Aktivovat rezim prihlednosti (Windows
7,Vista, XP).Vychoz( nastaveni je 0 %
neprihlednost.
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Options>Input (Moznosti>Vstup) — Tato
moznost bude aktivni pouze po vybéru
polozky Input (Vstup) v rozeviraci nabidce
Options (Moznosti). Na nepodporovaném
zobrazovacim zarizen( s podporou DDC/CI
jsou k dispozici pouze karty Help (Ndpovéda)
a Options (Moznosti). Zadné dali karty funkce
SmartControl Premium nejsou k dispozici.
PHILIPS

SmartControl Premium

Trput
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*  Zobrazi podokno s pokyny Source (Zdroj)
a nastaveni aktudiniho zdroje vstupu.

* U zobrazovacich zaf{zeni s jednim vstupem
nenf toto podokno zobrazeno.

Options>Audio (Moznosti>Zvuk) — Tato
moznost bude aktivni pouze po vybéru polozky
Audio (Zvuk) v rozeviraci nabidce Options
(Moznosti).

Na nepodporovaném zobrazovacim zarizenf s
podporou DDC/Cl jsou k dispozici pouze karty
Help (Ndpovéda) a Options (Moznosti).
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Nabidka Help (Napovéda)

Help>User Manual (Napovéda>Uzivatelska
prirucka) —Tato moznost bude aktivni pouze
po vybéru polozky User Manual (Uzivatelska

prirucka) v rozeviraci nabidce Help (Ndpovéda).

Na nepodporovaném zobrazovacim zafizen( s
podporou DDC/Cl jsou k dispozici pouze karty
Help (Napovéda) a Options (MoZnosti).
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Help>Version (Napovéda>Verze) — Tato
moznost bude aktivni pouze po vybéru
polozky Version (Verze) v rozeviraci nabidce
Help (Ndpovéda). Na nepodporovaném
zobrazovacim zarizeni s podporou DDC/CI
jsou k dispozici pouze karty Help (Ndpovéda) a
Options (Moznosti).
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Context Sensitive Menu (Nabidka mistni)

Context Sensitive Menu (Nabidka mistn) je
ve vychozi konfiguraci aktivovana. Nabidka
bude zobrazena po zadkrtnutf poloZzky Enable
Context Menu (Povolit nabidka mistni) v ¢dsti
Options (Moznosti)>podokno Preferences
(Predvolby).



a SmartControl Fremm

Select Preset
Tune Display
Power Saver

Economy

Context Menu (Mistni nabidka) obsahuje ctyri

polozky:

*  SmartControl Premium - po vybéru se
zobrazi obrazovka About (O aplikaci).

»  Select Preset (Vybrat predvolbu) — nabizf
hierarchickou nabidku uloZenych predvoleb
pro okamzité pouziti. Aktudlné vybrand
predvolba je oznacena zaSkrtnutim.

V rozeviraci nabidce Ize rovn&z vybrat
polozku Factory Preset (Predvolby
vyrobce).

* Tune Display (Ladéni zobrazeni) — otevie
ovladacf panel SmartControl Premium.

*  Smartlmage - Zkontrolujte aktudlnf
nastaveni: Off (Vypnuto), Office (Kanceldr),
Photo (Foto), Movie (Film), Text, Game
(Hra), Economy (Uspora).

Aktivovana nabidka hlavniho panelu
Nabidku hlavniho panelu lze zobrazit klepnutim
pravym tlacitkem mysi na ikonu SmartControl
Premium na hlavnim panelu. Klepnutim levym
tlacitkem Ize spustit aplikaci.
Find Windows |
Desktop Parition,.  #
[dentify Partition
Align On
Help
Technical Bupport
Check for Update
Ahout

I Exit g

16

Hlavnf panel obsahuje pét polozek:

* Help (Napovéda) — pristup k souboru s
uzivatelskou priruckou: Otevi'e soubor s
uzivatelskou priruckou v okné vychoziho
prohlizece.

*  Technical Support (Odborna pomoc) —
zobraz( stranku odborné pomoci.

*  Check for Update (Vyhledat aktualizace) —
zobrazi Uvodni stranku PDI a porovnd verzi
uZivatele s nejaktudIngjsi dostupnou verz.

*  About (O aplikaci) — zobrazf podrobné
referencni informace: verze produktu,
informace o vydanf a ndzev produktu.

*  Exit (Konec) — ukonci SmartControl
Premium.

Chcete-li znovu spustit funkci SmartControl
Premium, vyberte polozku SmartControl
Premium z nabidky Program, poklepejte

na ikonu na pracovni plose pocitace nebo
restartujte pocitac.

PHILIPS

SmartControl Premium

Deaktivovana nabidka hlavniho panelu

Kdyz je Hlavni panel deaktivovén ve slozce
Predvolby, je k dispozici pouze ¢ést Exit (Konec).
Chcete-li funkci SmartControl Premium zcela
odstranit z hlavniho panelu, deaktivujte polozku
Run at Startup (Spustit pri startu) v &asti
Options>Preferences (Moznosti>Predvolby).

€& Pozniamka

VSechny obrdzky v této sekci jsou pouze
orientacni.Verze softwaru SmartControl se
muze bez upozornéni ménit.Vzdy na oficidlnim
webu Portrait www.portrait.com/dtune/phl/
enu/index vyhledejte nejnovéjsi verzi softwaru
SmartControl.




4. Technické udaje

Obraz/displej

Typ zobrazovaciho panelu IPS-LCD

Podsvicenf LED

Velikost panelu 23" S (58,4 cm)

Pomér stran 16:9

Rozte¢ obrazovych bodl 0,2652 (v) mm x 0,2652 (s) mm
Jas 250 cd/m?

SmartContrast 20.000.000:1

Kontrastni pomér (typ.) 1000:1

Doba odezvy (typ.) 14 ms

Cas SmartResponse (typ.) 7 ms

Optimalnf rozlisenf

1920 x 1080 pri 60 Hz

Moznosti pripojeni
Vstup signdlu

Zorny Uhel 178° (H) / 178° (V) pri C/R > 10
Barevnost displeje 16,7 M

Vertikdlni obnovovaci frekvence 56 Hz — 76 Hz

HorizontdIni frekvence 30 kHz — 83 kHz

sRGB ANO

HDMI x2 (digitalnf), VGA (analogovy)

Vstupnf signal

Oddélend synchronizace, synchronizace podle zelené

Vystup zvuku
Usnadnéni
Usnadnéni pro uzivatele

Vystup zvuku HDMI

/< /Y ©O/A B/K o O

Jazyky nabidky OSD

anglictina, francouzstina, némcina, Spanélstina, italtina, rustina,
zjednodusena ¢instina, portugalstina

Dalsi usnadnénf

Zamek Kensington

Kompatibilita s technologif Plug

DDC/CI, sRGB, Windows 8/7/Vista/XE Mac OSX, Linux

& Play

Podstavec

Nadklon -5/+20
Rezim Zapnuto 28,6 W (typ.)
Spdnek (pohotovost) 03W
Vypnuto 03W

Indikdtor LED napdjenf

Zapnuto: Bild, Rezim Pohotovostni/spanku: Bila (blikd)

Napdjen(

Externf, 100 — 240 VAC, 50 — 60 Hz

Rozméry
Vyrobek s podstavce (5xVxH)

533 x 414 x 197 mm

Vyrobek bez podstavce (SxVxH)

533 x 325 x 44 mm
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Hmotnost

Vyrobek s podstavcem 3,80 kg
Vyrobek bez podstavce 3,35 kg
Vyrobek s obalem 567 kg

Provozni podminky

Teplotni rozsah (provoz) 0°C az 40°C

Rozsah teplot (mimo provoz) -20°C az 60°C

Relativni vihkost 20% az 80%

MTBF 30.000 hrs

ROHS ANO

EPEAT Silver (www.epeat.net)
Balenf 100% recyklovatelny
Specifické latky Kryt 1009 bez PVC BFR
Energy Star ANO

Shoda a normy

Prohlaseni o shodé

Oplasténi
Barva

CE Mark, FCC trfda B, SEMKO, UL/cUL, BSMI, GOST,
1SO9241-307, certifikdt TCO

Tmavé bronzova

Povrchovd Uprava

Leskly

© Poznimka

1.

N

Certifikdt EPEAT Gold nebo Silver je platny pouze tam, kde spolecnost Philips zaregistruje produkt.

Informace o stavu registrace ve vasi zemi viz www.epeat.net.

www.philips.com/support.

Tyto Udaje se mohou zménit bez predchoziho ozndment. Stadhnéte si nejnovejsi verzi letdku z webu
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4.1 Rezimy rozliseni a predvoleb

El Maximalni rozliseni
1920 x 1080 pri 60 Hz (analogovy vstup)
1920 x 1080 pri 60 Hz (digitalni vstup)

E1 Doporuéené rozliseni
1920 x 1080 pi 60 Hz (digitdini vstup)

Vodorovna Rozliseni Svisla

frekvence frekvence
(kHz) (Hz)
31,47 720 x 400 70,09
31,47 640 x 480 59,94
35,00 640 x 480 66,67
37,86 640 x 480 72,81
37,50 640 x 480 75,00
37,88 800 x 600 60,32
46,88 800 x 600 75,00
48,36 1024 x 768 60,00
60,02 1024 x 768 75,03

63,89 1280 x 1024 60,02
79,98 1280 x 1024 75,03
55,94 1440 x 900 59,89
70,64 1440 x 900 74,98
65,29 1680 x 1050 59,95
67,50 1920 x 1080 60,00

© Poznamka

Upozoriujeme vas, ze tento monitor funguje
nejlépe pri nativnim rozliseni 1920 x 1080 pri
60 Hz. Pro dosazeni optimaln( kvality zobrazenf
dodrzujte toto doporucené rozliSent.



5. Rizeni spotieby

Pokud je v daném pocitaci nainstalovan software
nebo videokarta vyhovujici normé DPM
organizace VESA, monitor dokdze automaticky
snizit svou spotiebu energie, neni-li pouzivan.
Pokud pocitac rozpozna vstup z kldvesnice,

mysi nebo jiného vstupniho zarizenf, monitor se
automaticky ,,probud*. Nasledujici tabulka uvadf
spotrebu energie a signalizaci této funkce pro
automatickou Usporu energie:

Definice rizenf spotreby

ReZimVESA | Video | H-synch.| V-synch. | Spotieba energie Eaaindi o

Aktivni ZAP Ano Ano 286W (typ.) Bild
(poift’;ii o V| Ne Ne 03W (typ) Bil4 (blika)
Vypnuto | VYR 5 g 03W (typ) VYR

Nasledujici konfigurace se pouzivd pri méren(
energetické spotreby tohoto monitoru.

* Nativni rozlisent: 1920 x 1080

*  Kontrast: 50%

e Jas: 250 nitd

» Barevnd teplota: 6500 K's pIné bilym

vzorkem

© Poznimka
Tyto Udaje se mohou zménit bez predchoziho
ozndment.
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6. Informace o regulaci

Congratulations!

This product is TCO Certified — for Sustainable
T

TCO Certified is an international
third party sustainability certification

for [T products. TCO Certified
ensures that the manufacture, use and recycling
of IT products reflect environmental, social and
economic responsibility. Every TCO Certified
product model is verified by an accredited
independent test laboratory.

This product has been verified to meet all the
criteria in TCO Certified, including:

Corporate Social Responsibility

Socially responsible production - working
conditions and labor law in manufacturing
country

Energy Efficiency

Energy efficiency of product and power supply.
Energy Star compliant, where applicable

Environmental Management System

Manufacturer must be certified according to
either ISO 14001 or EMAS

Minimization of Hazardous Substances

Limits on cadmium, mercury, lead & hexavalent
chromium including requirements for mercury-
free products, halogenated substances and
hazardous flame retardants

Design for Recycling

Coding of plastics for easy recycling. Limit on
the number of different plastics used.

Product Lifetime, Product Take Back

Minimum one-year product warranty. Minimum
three-year availability of spare parts. Product
takeback

Packaging

21

Limits on hazardous substances in product
packaging. Packaging prepared for recycling

Ergonomic, User-centered design

Visual ergonomics in products with a display.
Adjustability for user comfort (displays,
headsets) Acoustic performance — protection
against sound spikes (headsets) and fan noise
(projectors, computers) Ergonomically designed
keyboard (notebooks)

Electrical Safety, minimal electro-magnetic
Emissions

Third Party Testing

All certified product models have been tested
in an independent, accredited laboratory.

A detailed criteria set is available for download
at www.tcodevelopment.com, where you can
also find a searchable database of all TCO
Certified IT products.

TCO Development, the organization behind
TCO Certified, has been an international
driver in the field of Sustainable IT for 20 years.
Criteria in TCO Certified are developed in
collaboration with scientists, experts, users

and manufacturers. Organizations around the
world rely on TCO Certified as a tool to help
them reach their sustainable [T goals.We are
owned by TCO, a non-profit organization
representing office workers. TCO Development
is headquartered in Stockholm, Sweden, with
regional presence in North America and Asia.

For displays with glossy bezels, the user should
consider the placement of the display as the
bezel may cause disturbing reflections from
surrounding light and bright surfaces.

For more information, please visit
www.tcodevelopment.com

[}

GERTIFIED

Technology for you and the planet

(Only for selective models)



Lead-free Product

Lead free display promotes
environmentally sound recovery

@ and disposal of waste from electrical
and electronic equipment. Toxic
substances like Lead has been eliminated

and compliance with European community's
stringent RoHs directive mandating restrictions
on hazardous substances in electrical and
electronic equipment have been adhered to

in order to make Philips monitors safe to use
throughout its life cycle.

EPEAT

(www.epeat.net)

)  The EPEAT (Electronic
QQ Product Environmental
& Assessment Tool) program
evaluates computer
desktops, laptops, and monitors based on 51
environmental criteria developed through
an extensive stakeholder consensus process
supported by US EPA.

EPEAT system helps purchasers in the public
and private sectors evaluate, compare and
select desktop computers, notebooks and
monitors based on their environmental
attributes. EPEAT also provides a clear and
consistent set of performance criteria for the
design of products, and provides an opportunity
for manufacturers to secure market recognition
for efforts to reduce the environmental impact
of its products.

Benefits of EPEAT

Reduce use of primary materials
Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT'S
requirement that all registered products meet

ENERGY STAR's energy efficiency specifications,

means that these products will consume less
energy throughout their life.
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CE Declaration of Conformity

This product is in conformity with the following
standards

* EN60950-1:2006+A11:2009+A1:
2010+A12:2011 (Safety requirement of
Information Technology Equipment).

*  EN55022:2010 (Radio Disturbance
requirement of Information Technology
Equipment).

*  EN55024:2010 (Immunity requirement of
Information Technology Equipment).

+  EN61000-3-2:2006 +A1:2009+A2:2009
(Limits for Harmonic Current Emission).

*  EN61000-3-3:2008 (Limitation of Voltage
Fluctuation and Flicker) following provisions
of directives applicable.

*  2006/95/EC (Low Voltage Directive).

*  2004/108/EC (EMC Directive).

»  2009/125/EC (ErP Directive, EC No.
1275/2008 Implementing Directive
for Standby and Off mode power
consumption).

and is produced by a manufacturing organization
on 1ISO9000 level.

*  1SO9241-307:2008 (Ergonomic
requirement, Analysis and compliance test
methods for electronic visual displays).

*  TCO certified (Requirement for
Environment Labeling of Ergonomics,
Energy, Ecology and Emission, TCO: Swedish
Confederation of Professional Employees)
for TCO versions.



Energy Star Declaration

(www.energystar.gov)

As an ENERGY STAR® Partner;, we
have determined that this product

meets the ENERGY STAR”
guidelines for energy efficiency.

i)

& Note

We recommend you switch off the monitor
when it is not in use for a long time.

Federal Communications Commission (FCC)
Notice (U.S. Only)

© This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation.
This equipment generates, uses and can
radiate radio frequency energy and, if not
installed and used in accordance with the
instructions, may cause harmful interference
to radio communications.

However, there is no guarantee that
interference will not occur in a particular
installation. If this equipment does cause
harmful interference to radio or television
reception, which can be determined by
turning the equipment off and on, the
user is encouraged to try to correct

the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

»  Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

»  Consult the dealer or an experienced
radio/TV technician for help.

23

@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority
to operate the equipment.

Use only RF shielded cable that was supplied
with the monitor when connecting this monitor
to a computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

FC

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference that
may cause undesired operation.

Commission Federale de la Communication
(FCC Declaration)

& Cet équipement a été testé et déclaré
conforme auxlimites des appareils
numériques de class B,aux termes de
I'article 15 Des regles de la FCC. Ces
limites sont concues de facon a fourir
une protection raisonnable contre les
interférences nuisibles dans le cadre d'une
installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est
pas installé et utilisé selon les consignes
données, peuvent causer des interférences
nuisibles aux communications radio.



Cependant, rien ne peut garantir I'absence
d'interférences dans le cadre d'une
installation particuliére. Si cet appareil est
la cause d'interférences nuisibles pour

la réception des signaux de radio ou de
télévision, ce qui peut étre décelé en
fermant I'équipement, puis en le remettant
en fonction, |'utilisateur pourrait essayer de
corriger la situation en prenant les mesures
suivantes:

* Réorienter ou déplacer I'antenne de
réception.

* Augmenter la distance entre I'équipement
et le récepteur.

*  Brancher I'équipement sur un autre circuit
que celui utilisé par le récepteur

¢ Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

@ Toutes modifications n'ayant pas recu
I'approbation des services compétents
en matiére de conformité est susceptible
d'interdire a l'utilisateur I'usage du présent
équipement.

N'utiliser que des cables RF armés pour
les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTE TOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.

EN 55022 Compliance (Czech Republic Only)

“This davice belongs to catagory B devices a8 described in EN 55022, unless it is spaci-
cally stated that it i a Class A devics on the epeciication labal. The following applies to
devices in Class A of EN 55022 (radius of protection up 1o 30 metars). The user of the
davice is obligad to take all staps necessary o remove sources of interfarance to tals-
communication or other devicas.

Pokd neni na fypovém &tk potstase uvedena, # spedé do do tidy A podie EN 55022,
spada automaticky do tfidy B podle EN 55022, Pro zafizen! zafazend do tFidy A (chranné
pésma 30m) podie EN 5502 platl nésleduficl. Dojde-li k rullan! telskomunikatich nebo
finjich zafizani e uivatal povinnen provést takova opatfgni, atry nen odstranil,

Polish Center for Testing and Certification
Notice

The equipment should draw power from a
socket with an attached protection circuit (a
three-prong socket). All equipment that works
together (computer, monitor, printer, and so on)
should have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/1T-42107
and PN-89/E-06251.

Wymagania Polskiege Centrum Badan i Certyfikacji
Uzpedzenie powiano byt rasilane z paiasds 2 preylaceonym obwodem ochronmym (gnisedo
katkiem). Wapdipracuiaee 2 soby ufzadzenia (Komputer, monitor, drukarka) powinty bye msilane
& togo samego dridla
Instalacja elektrycna pomiesaczenia powinna mwie
przs zwarciami, w postaci bezpieconika o warke
W el catkowitogo wybyerenia urspdzents 2 siect zasilania, nalezy wyint wiycekg kabla
easilajacega = poazdka, kidre powinno ssidowad s w pobliz urmJJanm:I!\t Batwi dosiepne.
Znak bespieczefsrwa "B” potwierdzs 2podnosé uresdzenia » wymaganiami bezpiecsefaiwa
whytkowania awartymi w PN-93T-42107 | PN-§9E-D6;

w przeworksie fzowym rezecrowa achrang
marmienavwe] e wicksej ni 164 (amperiuw).

Pozostale instrukcje bezpieczensiwa

* Niemaledy urywad wiyceek sdapterowych lub usuwaé kolka abwedu ackrornego 2 wiyeeki.
Jekeli Lu\m‘WIILJLJ LRy |:|1:\:\Jlural‘ra o naledy whyd preediuzace 3-pylowego 2
System kmpalerowy rnlny sabezpivcryt prred nagtymi, chwilow
ac eliminatora preepied, urradrenia dopasow
berzakidceniowe irinia zasilania.

tic nie leZalo na kablach systemu kompuierowego, arz aby kable nie
dzse tokna byloby na sie nadeptywad lub poryksd sig o nie.

warostami lub spad-
X

T e p——

Nie maleiy wpychad adnych preedmiotion do atwost sy
podar lub porpenie pridem, poprzez o

najdowad sig 2 dala od g

Tacyjnych. Nakezy un
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North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR
DU STALLER DIN UTRUSTNING PAPLATS.

Placering/Ventilation

ADVARSEL:

SORG VED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT
ER NEMT TILGANGELIGE.

Paikka/llmankierto

VAROITUS:

SIJOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR
ST@MTILF@RSEL ER LETTE A NA.

BSMI Notice (Taiwan Only)
RRZHENERIBE |

Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht
den in der "Verordnung Uber den Schutz vor
Schiden durch Réntgenstrahlen” festgelegten
Vorschriften.

Auf der Rickwand des Gerites befindet sich

ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften
Uber die Bauart von Storstrahlern nach Anlage
a5 Abs. 4 der Rontgenverordnung erflillt sind.

Damit Ihr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, dal3

1. Reparaturen nur durch Fachpersonal
durchgefiihrt werden.
2. nur original-Ersatzteile verwendet werden.

bei Ersatz der Bildréhre nur eine
bauartgleiche eingebaut wird.

Aus ergonomischen Griinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf]
dunklem Untergrund zu verwenden (schlechte
Lesbarkeit und erhohte Augenbelastung bei zu
geringem Zeichenkontrast wéren die Folge).
Der arbeitsplatzbezogene Schalldruckpegel
nach DIN 45 635 betrdgt 70dB (A) oder
weniger.

() ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLUB LEICHT
ZUGANGLICH SIND.



EU Energy Label

LF Energy Labed

[ [evecgs]

PHILIPS

]

The European Energy Label informs you on
the energy efficiency class of this product.
The greener the energy efficiency class of this
product is the lower the energy it consumes.

On the label, you can find the energy efficiency
class, the average power consumption of

this product in use and the average energy
consumption for 1 year.

& Note

The EU Energy Label will be ONLY applied on

the models bundling with HDMI and TV tuners.
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China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products produced and sold for China
market have to meet China RoHS request.
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7. Péce o zakazniky a zaruka

7.1 Postup pri vadnych pixelech
plochého panelu spolecnosti
Philips

Spolecnost Philips se snazi doddvat produkty

vyrobnich postup( vyroby v tomto odvétvi a

prosazuje prisnou kontrolu kvality. Defektim

obrazovych bodl nebo dil¢ich obrazovych
bodd u panelt monitord TFT, které se pouzivajf
pro ploché monitory, se nicéné nékdy nedd
zabranit. Zadny vyrobce nemuize zarudit, ze
viechny panely budou bez defektd obrazovych
bod, ale spole¢nost Philips zarucuje, ze kazdy

monitor s neprijatelnym poctem defektd bude v

ramci zaruky opraven nebo vymeénén.Tento text

vysvétluje jednotlivé druhy defektl na pixelech

a urcuje Unosnou Uroven chybovosti pro kazdy

druh. Aby bylo mozné uplatnit zdrucni opravu

nebo vyménu, musi pocet defektnich obrazovych
bodl panelu monitoru TFT presdhnout tuto

Uroveri Unosnosti. Na monitoru napriklad nesmf

byt vice defektnich dil¢ich obrazovych bodd nez

0,0004 %. Dile, protoze nékteré typy kombinaci

vad pixeld jsou Iépe postrehnutelné nez jiné,

stanovuje pro né spolecnost Philips jesté veétst
naroky na kvalitu. Tato norma se dodrzuje
celosvétove.

subpixely

RGB[W
Pixely

Pixely a subpixely

Pixel, neboli obrazovkovy bod, se sklddd ze
subpixeld v zdkladnich barvéch cervené, zelené a
modré. Kdyz je mnoho pixeld pohromadé, tvorf
obraz. Kdyz viechny subpixely ur¢itého pixelu
svitf, jevi se tyto tfi subpixely spolecné jako
jediny bily pixel. Kdyz jsou viechny tmavé, jevi
se tyto tfi subpixely jako jeden cerny pixel. Dalsf

kombinace rozsvicenych a tmavych subpixell se
jevi jako pixely rliznych barev.

Druhy pixelovych vad

Vady pixell a subpixell se na obrazovce
projevuji riznymi zpUsoby. Existuji dva druhy vad
pixelu a v rdmci téchto druhd je nékolik typl
subpixelovych vad.

Defekty svétlych bodu

Defekty svétlych bodl se projevuji jako
obrazové body nebo dil¢i obrazové body, které
vzdy sviti nebo jsou ,,aktivni*. Svétly bod je dil¢f
obrazovy bod, ktery vystupuje z obrazovky, kdyz
je na monitoru zobrazena tmavd plocha. Existujf
nasledujici typy defektd svétlych bodu.

Jeden cerveny, zeleny nebo modry subpixel.

I C

Dva soundlezici subpixely:

- Cerveny + modry = fialovy

- Cerveny + zeleny = Zluty

- zeleny + modry = svétle modry

Tri soundlezici rozsvicené subpixely (jeden bily
pixel).



€& Poznimka

Cerveny nebo modry svétly bod musf byt o
vice nez 50 procent jasngjsi, nez sousedni body;
zeleny svétly bod je o 30 procent jasnéjsi, nez
sousedn( body.

Defekty tmavych bodu

Defekty tmavych bodud se projevuji jako
obrazové body nebo dil¢i obrazové body, které
nikdy nesvitf nebo jsou ,,neaktivni. Tmavy bod je
dil¢i obrazovy bod, ktery vystupuje z obrazovky,
kdyz je na monitoru zobrazena svétld plocha.
Existuji ndsledujicl typy defektd tmavych bodu.

Vzdalenost pixelovych vad

ProtoZe vady pixell a subpixell stejného

typu, které se vyskytuji blizko sebe, mohou byt
patrnéjsi, urcuje spolecnost Philips i tolerance na
vzddlenost vad pixeld.

Tolerance vad pixeld

Aby bylo mozné uplatnit opravu nebo vyménu
kvadli defektnim obrazovym bodlm v zaru¢nf
dobé, musi panel TFT v plochém monitoru
Philips vykazovat defekty obrazovych bodl
nebo dil¢ich obrazovych bodu, které prekracujf
tolerance uvedené v nasledujicich tabulkéch.

KAZY JASNYCH BODU

PRIJATELNY POCET VAD

1 trvale svitici bod 3
2 sousedn/ trvale svitici body 1
3 sousedni trvale svitici body (nebo 1 trvale svitici bily bod) 0
Vzddlenost mezi dvéma kazy jasnych bod* >15 mm
Celkovy pocet kaz{ jasnych bodud viech typl 3

KAZY CERNYCH BODU
1 tmavy bod

PRIJATELNY POCET VAD
5 nebo méné

2 sousedni tmavé body

2 nebo méné

3 sousedni tmavé body

0

Vzddlenost mezi dvéma kazy cernych bodi*

>15 mm

Celkovy pocet kazli cernych bodu viech typl

5 nebo méné

KAZY BODU CELKEM

PRIJATELNY POCET VAD

Celkovy pocet kazll jasnych nebo cernych bodut viech typl

5 nebo méné

€& Poznimka

1. 1 nebo 2 sousedni vadné body (1 barva) = 1 vadny bod

2. Tento monitor vyhovuje normé 1SO9241-307, tiida | (1ISO9241-307: Ergonimicky pozadavek, analyza
a metody testovani shody pro elektronickd zobrazovaci zarizenr)

normalizaci (ISO) dle: 2008-11-13.
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7.2 Péce o zakazniky & zaruka

Podrobné informace o zéruce a pozadavku na dodate¢nou podporu platné pro vasi oblast najdete na
webu www.philips.com/support. Rovnéz mizete kontaktovat mistni centrum péce o zdkazniky na nize
uvedenych telefonnich &islech.

Kontaktni informace pro oblast ZAPADNI EVROPY:

Zemé ASC Cislo zakaznické péce Cena
Germany Siemens 1&S +49 01803 386 853 €009

United Kingdom Invec Scotland +44 0207 949 0069 Local call tariff
Ireland Invec Scotland +353 01 601 1161 Local call tariff
Spain Eatsa Spain +34 902 888 785 €0,10

Finland A-novo +358 09 2290 1908 Local call tariff
France A-novo +33 082161 1658 €009

Greece Allman Hellas +30 00800 3122 1223 Free of charge
Italy A-novo +39 840 320 041 €0,08
Netherlands E Care +31 0900 0400 063 €010
Denmark A-novo +45 3525 8761 Local call tariff
Norway A-novo +47 2270 8250 Local call tariff
Sweden A-novo +46 08 632 0016 Local call tariff
Poland Zolter +48 0223491505 Local call tariff
Austria Siemens 1&S +43 0810 000206 €007
Belgium E Care +32 078 250851 €0,06
Luxembourg E Care +352 26 84 30 00 Local call tariff
Portugal Eatsa Spain +351 2 1359 1440 Local call tariff
Switzerland A-novo +41 02 2310 2116 Local call tariff
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Kontaktni informace pro oblast STREDNI AVYCHODNI EVROPY:

::fr!::ioi:l:; Cislo zakaznické péce
Belarus NA IBA +375 17 217 3386
Bulgaria NA LAN Service +359 2 960 2360
Croatia NA Renoprom +385 1 333 0974
Estonia NA FUJITSU +372 6519900
Latvia NA “ServiceNet LV Ltd. +371 7460399
Lithuania NA UAB "Servicenet" +370 7400088
Romania NA Blue Ridge Intl. +40 21 2101969
ﬁfg:'fe fegm NA i Tee A +381 11 20 70 684
Slovenia NA PC H.and +386 1 530 08 24
et NA Comel +380 562320045
NA Topaz-Service Company +38 044 245 73 31
. NA CPS +7 (495) 645 6746 (for repair)
NA CEEE Partners +7 (495) 645 3010 (for sales)
Slovakia NA Datalan Service +421 2 49207155
Turkey NA Techpro +90 212 444 4 832
Czech Rep. NA Asupport 800 100 697
Hungary NA Serware . +36 1 2426331
NA Profi Service +36 1 814 8080

Kontaktni informace pro oblast LATINSKE AMERIKY:

Telefonni stredisko

Brazil

Vermont

Argentina

Cislo zakaznické péce
0800-7254101

0800 3330 856

Kontaktni informace pro Cinu:
Cina

Cislo zdkaznické péce: 4008 800 008

Kontaktni informace pro SEVERNI AMERIKU:

Telefonni <, g f LA (53

stredisko Cislo zakaznické péce
USA. EPI - e-center | Qwantech (877) 835-1838
Canada Supercom Supercom (800) 479-6696
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Kontaktni informace pro oblast APMEA:

Telefonni
stredisko

Cislo zakaznické péce

Australia NA AGOS NETWORK PTY LTD | 1300 360 386
New Zealand | NA Visual Group Ltd. 0800 657447
Hong Kong / : Hong Kong:Tel: +852 2619 9639
Macau NA Smart Pixels Technology Ltd. | 1. i Tel: (853)-0800-987
. Tel:1 800 425 6396
India NA REDINGTON INDIA LTD SMS: PHILIPS to 56677
Indonesia NA PT. Gadingsari elektronika Prima UEBCA 2 B, I
7511530
South Korea | NA PCS One Korea Ltd. 080-600-6600
. After Market Solutions (CE)
Malaysia NA Sdn Bhd 603 7953 3370
Pakistan NA Philips Consumer Service (9221) 273741116
Philips Electronics Singapore
Singapore NA Pte Ltd (Philips Consumer Care | (65) 6882 3999
Center)
PCCW
Taiwan Teleservices FETEC.CO 0800-231-099
Taiwan
Thailand NA Axis Computer System Co,, Ltd. | (662) 934-5498
South Africa NA Sylvara Technologies Pty Ltd 086 0000 888
onited Arab 0 AL SHAHD COMPUTER LL.C |00971 4 2276525
Emirates
Israel NA Eastronics LTD 1-800-567000
EPT Service Informatic +84 8 38248007 Ho Chi Minh City
Vietnam NA Cormpany Lid +84 5113.562666 Danang City
Py +84 5113.562666 Can tho Province
I . (02) 633-4533 to 34,
Philippines NA Glee Electronics, Inc. (02) 637-6559 1o 60
Sri Lanka NA no d}s‘trlbutor and/or service
provider currently
Bancladesh NA Distributor: Computer Source | 880-2-9141747,9127592
g Ltd (warranty buy-out) 880-2-8128848 / 52
Nepal NA Distributor: Syakar Co. Ltd 977-1-4222395
(warranty buy-out)
Distributor: Neat Technology
Cambodia NA Pte Ltd (Singapore) (warranty [ 855-023-999992
buy-out)
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8. Odstranovani probléma a
Casté dotazy

8.1

Na této strdnce jsou uvedeny problémy,
které mlze odstranit uzivatel. Pokud problém
pretrvavd i po vyzkouseni téchto resent,
kontaktujte zdstupce sluzeb pro zdkazniky
spolecnosti Philips.

Odstranovani problému

El Bé&iné problémy

Zadny obraz (indikator LED napajeni nesviti)

»  Zkontrolujte, zda je napdjeci kabel pripojen
k elektrické zdsuvce a do zadnf casti
monitoru.

*  Nejdrfve zkontrolujte, zda se vypinac
na prednf stran& monitoru nachdzi ve
VYPNUTE poloze a stisknéte jej do
ZAPNUTE polohy.

Zadny obraz (indikator LED napéjeni je bily)

»  Zkontrolujte, zda je zapnuty pocitac.

»  Zkontrolujte, zda je kabel signdlu rddné
pripojen k pocitaci.

»  Zkontrolujte, zda nejsou ohnuté koliky na

pripojovaci strané kabelu monitoru. Pokud
ano, opravte nebo vymérite kabel.

* Pravdépodobné je aktivovadna funkce rizenf
spotreby

Obrazovka Fika

Attention

Check cable connection

»  Zkontrolujte, zda je kabel monitoru radné
pripojen k pocitaci. (Rovnéz viz Strucnd
prirucka).

*  Zkontrolujte, zda nejsou ohnuté koliky
kabelu monitoru.

»  Zkontrolujte, zda je zapnuty pocitac.
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Tlaéitko AUTO nefunguije.

* Automatickd funkce je pouzitelnd pouze
v rezimu VGA-Analog (VGA-analogovy).
Pokud vysledek nenf uspokojivy, mizete
provést rucni Upravy prostrednictvim
nabidky OSD.

€& Pozniamka

Auto funkce nenf pouzitelnd v rezimu DVI-

Digital (DVI-digitdIni), protoZe je zbytecna.

Viditelné znamky koure nebo jiskFeni

*  Neprovddéjte zddné kroky pro
odstraffovani probléma

*  Pro zajisténi bezpecnosti ihned odpojte
monitor od zdroje napdjenf

* |hned kontaktujte zdstupce sluzeb pro
zdkazniky spolecnosti Philips.

Bl Problémy se zobrazenim

Obraz neni vystredén

* Upravte polohu obrazu pomocf funkce
,Auto” v hlavnich ovlddacich prvcich OSD.

» Upravte polohu obrazu pomoci polozek
Phase/Clock (Faze/Frekvence) v ¢asti Setup
(Nastaven) v hlavni ovlddaci prvky OSD.
Tato funkce je platnd pouze v rezimu VGA.

Obraz se chvéje na obrazovce

»  Zkontrolujte, zda je kabel signdlu rddné a
bezpelné pripojen ke grafické desce nebo
k pocitaci.

Dochazi ke svislému blikani

*  Upravte polohu obrazu pomocf funkce
,Auto” v hlavnich ovlddacich prvcich OSD.

*  Omezte svislé pruhy pomoci polozek
Phase/Clock (Féze/Frekvence) v ¢asti Setup
(Nastaven) v hlavni ovlddaci prvky OSD.
Tato funkce je platnd pouze v rezimu VGA.



Dochazi k vodorovnému blikani

* Upravte polohu obrazu pomoci funkce
,Auto™ v hlavnich ovlddacich prvcich OSD.

*  Omezte svislé pruhy pomoci polozek
Phase/Clock (Faze/Frekvence) v ¢asti Setup
(Nastaveni) v hlavni ovlddaci prvky OSD.
Tato funkce je platnd pouze v rezimu VGA.

Obraz je rozmazany, nevyrazny nebo pfilis
tmavy

* Upravte kontrast a jas na obrazovce OSD.

,Dosvit", ,,vypéleni* nebo ,,zobrazeni duchi*

zlstane po vypnuti napéjeni.

*  Dlouhodobé neprerusované zobrazenf
nehybného nebo statického obrazu mize
zpUsobit ,,vypéleni* obrazovky, rovnéz
znamé jako ,,dosvit"* nebo , zobrazenf
duchd"., Vypéleni*, ,,dosvit" nebo
,,zobrazenf duchl" je dobre zndmy jev
u technologie panelt LCD.V mnoha
pripadech ,vypdleni, , dosvit" nebo
,,zobrazenf duchl" postupné zmizf po
uréité dobé mimo provoz.

* Pred ponechdnim monitoru bez dozoru
vzdy aktivujte sporic obrazovky.

* Bude-li na vasem monitoru LCD zobrazen
nemeénici se staticky obsah, vzdy aktivujte
aplikaci pro pravidelnou obnovu obrazovky.

*  Pokud neaktivujete spori¢ obrazovky nebo
aplikaci, kterd pravidelné obméniuje obsah
zobrazenf, mze dojit k vdznému ,,vypdleni*,
,,dosvitu"* nebo ,,zobrazenf duch(”, a toto
naruseni obrazu jiz nelze odstranit. Na vyse

uvedené poskozeni se nevztahuje zdruka.

Obraz je zdeformovany.Text je nejasny nebo
rozmazany.

» Nastavte rozliseni zobrazeni pocitace
na stejny rezim, v jakém se nachdzf
doporucené nativni rozliseni obrazovky
monitoru.
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Na obrazovce se objevuji zelené, éerveng,
modré, tmavé a bilé tecky

»  Zbyvajici body jsou normdlnf vlastnostf
tekutych krystald pouzivanych souc¢asnou
technologii. Dalsi podrobnosti viz pravidla
pro obrazové body.

Svétlo indikatoru ,,napajeni* je prilis silné a

rusi

*  MulZete nastavit intenzitu svétla indikdtoru
,napdjeni v ¢asti Indikdtor LED napdjenf
v ¢dsti Nastaven( v hlavni ovlddacf prvky
nabidky OSD.

Potrebujete-li dalsi pomoc, viz seznam
Informacnf strediska pro zdkazniky a kontaktujte
zéstupce sluzeb pro zékazniky spolecnosti
Philips.

8.2 SmartControl Premium - casté
dotazy

Ot.1:  Zmeénil jsem monitor v pocitaci za jiny
a technologie SmartControl Premium
se stala nepouzitelnou, co mam délat?
Odp.: Restartujte pocitac a zjistéte, zda
technologie SmartControl Premium
funguje.V opacném pripadé bude
tfeba odebrat a znovu nainstalovat
SmartControl Premium, aby bylo
zajisténo, Ze je nainstalovdn spravny
ovladac.

Ot.2: Technologie SmartControl Premium
drive dobre fungovala, ale nyni
nefunguje, co mam délat?

Odp.: Pokud byly provedena nésledujici kroky,
bude pravdépodobné nutné znovu

nainstalovat ovlada¢ monitoru.
* Pouzijte jiny graficky adaptér videa
»  Zaktualizujte ovladac videa
+ Cinnosti na opera¢nim systému, napiiklad
aktualizace nebo oprava

*  Spustte sluzbu Aktualizace Windows a
zaktualizujte ovladac¢ monitoru a/nebo videa



*  Operacnf systém Windows byl zaveden,
kdyz byl monitor vypnuty nebo odpojeny.

*  Chcete-li ziskat dalsi informace, kliknéte
pravym tlacitkem mysi na My Computer
(Tento pocitac) a kliknéte na Properties
(Vlastnosti) -> Hardware -> Device
Manager (Sprévce zarizeni).

* Pokud je pod polozkou Monitor uvedeno
,,Plug and Play Monitor” (Monitor Plug
and Play), je tfeba provést novou instalaci.
JednoduSe odeberte a znovu nainstalujte
SmartControl Premium .

Ot 3:

Odp.:

Ot. 4

Odp.:

Kdyz po nainstalovani SmartControl
Premium kliknu na kartu SmartControl
Premium, ani po chvili se nic nezobrazi
nebo se zobrazi zprava o chybé, co se
stalo?

V&3 graficky adaptér pravdépodobné
neni kompatibilni s technologif
SmartControl Premium. Pokud je vas
graficky adaptér mezi vyse uvedenymi
znackami, zkuste stéhnout nejaktudingjsi
ovladac grafického adaptéru z webovych
stranek prislusného vyrobce. Nainstalujte
ovlada¢. Odeberte a znovu nainstalujte
SmartControl Premium.

Pokud presto nefunguje, graficky
adaptér bohuzel neni podporovén. Na
webovém serveru spolecnosti Philips
zjistéte, zda je k dispozici zaktualizovany
ovlada¢ SmartControl Premium.

Po kliknuti na Product Information
(Informace o produktu) se zobrazi
pouze casteéné informace, co se stalo?

Pravdépodobné nemdte k dispozici
nejaktudIngjsi verzi ovladace adaptéru
grafické karty, kterd pIné podporuje
rozhranf DDC/CI. Pokuste se stdhnout
nejaktudlnéjsi ovladac grafického
adaptéru z webovych strdnek
prislusného vyrobce. Nainstalujte
ovlada¢. Odeberte a znovu nainstalujte
SmartControl Premium.
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Attention

Theft Deterence is Enabled

Ot.5: Zapomnél jsem svuj kéd PIN pro
funkci Theft Deterrence (zabezpeceni
proti kradezi). Co mam délat?

Odp.:  Servisni stedisko Philips ma pravo

Zadat legitimnf identifikaci a ovéren( pro
Zjistén( vlastnictvi monitoru.

8.3 Obecné casté dotazy

Ot.1: Kdyz nainstaluji svj monitor, co

mam udélat, kdyz se na obrazovce
zobrazi zprava ,,Cannot display this
video mode* (Tento rezim videa nelze
zobrazit)?

Odp.: Doporucené rozliseni pro tento
monitor: 1920 x 1080 pri 60 Hz.

Odpojte vsechny kabely, potom pripojte
pocitac¢ k monitoru, ktery jste pouzili
predtim.

* V nabidce Start operacniho systému
Windows vyberte Settings/Control Panel
(Nastaveni/Ovladaci panely).V okné
ovlddacf panely vyberte ikonu Display
(Zobrazenf). Na panelu ovlddani Display
(Zobrazenf) vyberte kartu , Settings"
(Nastaven). Na karté nastaveni v poli
oznaceném ,,Desktop Area” (Pracovnf
Plocha) presurite posuvnik na 1920 x 1080
obrazovych bodu.

*  Klepnéte na ,,Advanced Properties"
(Pokrocilé), nastavte polozku Refresh Rate
(Obnovovaci frekvence) na 60 Hz a potom
klepnéte na OK.

* Restartujte pocita¢ a zopakovanim kroku 2
a 3 ovérte, zda je pocita¢ nastaven na 1920
x 1080 pri 60 Hz.

*  Vypnéte pocitag, odpojte stary monitor a
znowvu pripojte monitor LCD Philips.

» Zapnéte monitor a potom zapnéte pocitac.



Ot. 2:

Odp.:

Ot. 3:

Odp.:

Ot. 4
Odp.:

Ot.5:

Odp.:

Ot. 6:

Odp.:

Jaka je doporuéena obnovovaci
frekvence monitoru LCD?

Doporucena obnovovac( frekvence LCD
monitoru je 60 Hz.V pripadé jakéhokoli
ruseni na obrazovce ji mdzete nastavit
na 75 Hz a uvidite, zda rusenf zmizi.

Co jsou soubory .inf a .icm na disku
CD-ROM? Jak Ize nainstalovat ovladace
(:inf a .icm)?

Jednd se o soubory ovladace monitoru.
Pri instalaci ovladacd postupujte

podle pokyn( v uzivatelské prirucce.

Pri prvnf instalaci bude pocita¢
pravdépodobné pozadovat ovladace
monitoru (soubory .inf a .icm) nebo
disk s ovladaci. Postupujte podle pokynd
a vlozte (doprovodny disk CD-ROM),
ktery je soucdsti této sady. Ovladace
monitoru (soubory .inf a .icm) budou
nainstalovany automaticky.

Jak mam upravit rozliSeni?

Dostupnd rozlisenf urcuje grafickd karta/
ovlada¢ grafiky a monitor: Pozadované
rozlideni mizete vybrat v casti Control
Panel (Ovladac( panely) systému
Windows® v &sti , Display properties”
(Vlastnosti zobrazen).

Co kdyz se béhem nastaveni monitoru
ztratim prostrednictvim nabidky OSD?

Jednoduse stisknéte tladitko OK a
potom volbou ,Reset” (Obnovit)
obnovte viechna plvodni nastaven(
vyrobce.

Je obrazovka LCD odolna proti
poskrabani?

Obecné se doporucuje nevystavovat
povrch panelu nadmérnym dderlim a
chrénit jej pred ostrymi nebo tupymi
prredméty. Pri manipulaci s monitorem
nevyvijejte na povrch panelu zadny tlak
ani silu. Mohlo by to negativné ovlivnit
vase zdrucni podminky.
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Ot.7: Jak Ize Cistit povrch monitoru LCD?

Odp.:  Pro bézné cisténi pouzijte Cisty a mekky
hadrik. Pro dikladné cisténl pouZijte
izopropyl alkohol. Nepouzivejte Zadna
jind rozpoustédla, jako etylalkohol,
etanol, aceton, hexan atd.

Ot.8: Lze ménit nastaveni barev monitoru?

Odp.:  Ano, nastaveni barev mlzete zménit
prostrednictvim nabidky OSD podle
nasledujicich krokd:

e Stisknutim tlacitka ,,OK" zobrazte nabidku
OSD.

«  Stisknutim tlagitka ,,Down Arrow" (Sipka
doll) vyberte volbu ,,Color (Barva)
a stisknutim tlacitka ,,OK" prejdéte
na nastaveni barev. K dispozici jsou trf
nastaveni (viz nize).

1. Color Temperature (Barevna teplota):
k dispozici je Sest nastaveni: 5000K,
6500K, 7500K, 8200K, 9300K a 11500K.
Pri nastaven( v rozsahu 5000K vypadajf
barvy na panelu ,teplé s ¢ervenobilym
barevnym ténem", zatimco pri nastaven(
teploty 11500K vypadaji barvy na
panelu , studené s modrobilym
barevnym ténem".

2. sRGB:jde o standard pro zajisténf
sprdvného podani barev na rdznych
zafizenich (napr’. digitdIni fotoapardty,
monitory, tiskdrny, skenery atd.)

3. User Define (Uzivatelské): uzivatel
si mGze zvolit vlastni nastaveni barev
upravenim cervené, zelené a modré
slozky.

€& Poznimka

Méren( svétla barvy, které vyzaruje predmét pri
zahrfvani. Toto mérenf je vyjddreno v absolutnim
meéritku (stupné Kelvina). Nizsi teploty Kelvina,
napriklad 2004 K| jsou Cervené; vyssi teploty, jako
napriklad 9300 K jsou modré. Neutrdlni teplota
je bild pri 6504 K.



Oot.9:

Odp.:

Ot.10:

Odp.:

Ot.11:

Odp.:

Lze pripojit tento monitor LCD k
libovolnému pocditaci, pracovni stanici
nebo pocitaci Mac?

Ano.Vsechny monitory LCD Philips
jsou pIné kompatibilnf se standardnimi
pocftadi, pocftaci Mac a pracovnimi
stanicemi. Pro pfipojeni monitoru

k systému Mac mlZe byt zapotrebl
kabelovy adaptér. Dalsi informace vdm

Philips.

Jsou monitory Philips LCD vybaveny
technologii Plug-and-Play?

Ano, tyto monitory jsou kompatibilni s
technologii Plug-and-Play v opera¢nim
systému Windows 8/7/Vista/XP/NT, Mac
OSX; Linux

Co znamena Ipéni obrazu, vypaleni
obrazu, dosvit nebo ,,duch*
v souvislosti s panely LCD?

Dlouhodobé neprerusované zobrazenf
nehybného nebo statického obrazu
mUze zpUsobit , vypaleni* obrazovky,
rovnéz zndmé jako ,,dosvit" nebo
,.zobrazenf duchd”. , Vypélenf, , dosvit"
nebo ,zobrazeni duchi" je dobre
zndmy jev u technologie panell LCD.

V mnoha pripadech ,,vypdleni*, , dosvit"
nebo , zobrazeni duchl" postupné zmizf
po urcité dobé mimo provoz.

Pred ponechdnim monitoru bez dozoru
vzdy aktivujte sporic¢ obrazovky.

Bude-li na vasem monitoru LCD
zobrazen neménicf se staticky obsah,
vzdy aktivujte aplikaci pro pravidelnou
obnovu obrazovky.

) Vystraha
Pokud neaktivujete spori¢ obrazovky nebo

aplikaci,

kterd pravidelné obménuje obsah

zobrazeni, mdze dojit k vaznému ,,vypdleni*,
,,dosvitu" nebo ,,zobrazeni duch", a toto
naruseni obrazu jiz nelze odstranit. Na vyse
uvedené poskozenf se nevztahuje zaruka.
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Ot. 12: Proc se na displeji nezobrazuje ostry

Odp.:

text a pro¢ maji zobrazené znaky
zubaté okraje?

Vé&s LCD monitor nejlépe pracuje pri
svém nativnim rozliseni 1920 x 1080
pri 60 Hz. Pouzivejte toto rozliseni pro
dosazeni optimalntho zobrazen.



PHILIPS

A
%

© 2012 Koninklijke Philips Electronics N.V.Vsechna prava vyhrazena.
Philips a emblém Stitu Philips jsou registrované obchodni znamky
Koninklijke Philips Electronics N.V.a jsou pouzivany v licenci od
Koninklijke Philips Electronics N.V.

Udaje mohou byt bez predchoziho upozornéni zménény.

Verze: M4238CE1T



